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Το παρόν υλικό διατίθεται με τους όρους της άδειας χρήσης:  

Creative Commons - Αναφορά - Παρόμοια Διανομή 4.0  

 

 

Ο Οδηγός αυτός βασίστηκε στους επίσημους οδηγούς του Mendeley (Elsevier) που μπορείτε 

να βρείτε στον εξής σύνδεσμο: https://www.mendeley.com/guides 

Ο επίσημος Οδηγός της Βιβλιοθήκης  για την προηγούμενη εκδοχή Mendeley Desktop: 

https://www.lib.auth.gr/sites/default/files/docs_files/MendeleyGuide_Greek_Final.pdf  

 

Επιμέλεια: Ελένη Τζαβέλλα 

Για αναλυτικότερες οδηγίες  μπορείτε να επικοινωνείτε με την Υπηρεσία Εκπαίδευσης 

Χρηστών της Βιβλιοθήκης στο τηλ. 2310 994216 ή στο email ltraining@lib.auth.gr 

    

Σημείωμα αναφοράς: 

Βιβλιοθήκη & Κέντρο Πληροφόρησης ΑΠΘ, Εκπαίδευση Χρηστών. (2023).  Mendeley 

Reference Manager: Οδηγός Χρήσης. https://www.lib.auth.gr/el/node/1471 

 

 

 

 

 

                                                            

https://creativecommons.org/licenses/by/4.0/
https://creativecommons.org/licenses/by/4.0/
https://creativecommons.org/licenses/by/4.0/
https://creativecommons.org/licenses/by/4.0/
https://creativecommons.org/licenses/by/4.0/
https://www.mendeley.com/guides
https://www.lib.auth.gr/sites/default/files/docs_files/MendeleyGuide_Greek_Final.pdf
mailto:ltraining@lib.auth.gr
https://www.lib.auth.gr/el/node/1471
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1. Σχετικά με το Mendeley Reference Manager 

To Mendeley Reference Manager είναι πρόγραμμα δημιουργίας & διαχείρισης 

βιβλιογραφικών αναφορών. Εκτός από την διαδικτυακή εκδοχή του, υπάρχει και η 

αντίστοιχη εφαρμογή για την επιφάνεια εργασίας. 

Η παλαιότερη εκδοχή  Mendeley Desktop  εξακολουθεί να ισχύει για όσους την είχαν 

εγκαταστήσει παλαιότερα και δουλεύουν ακόμα με αυτήν. Κάποια στιγμή θα καταργηθεί και 

οι χρήστες θα μεταβούν στην νέα εκδοχή. Οι αναφορές θα συγχρονιστούν αυτόματα  στη νέα 

έκδοση. Οι χρήστες  θα ειδοποιηθούν εγκαίρως για την μετάβαση. 

 

2. Συμβατότητα συστημάτων 

 Λειτουργικά συστήματα: Linux (64 bit), Windows (7+νεότερες), Mac (OS X 10.10 + 

νεότερες) 

 Φυλλομετρητές:    Microsoft Edge, Google Chrome, Firefox, Safari 

 Επεξεργαστές κειμένου για το εργαλείο Mendeley Cite Add-In: Microsoft Word 365, 

Microsoft Word 2016  

 

3. Δημιουργία  λογαριασμού  

Αν επιθυμώ λογαριασμό στη βασική έκδοση του Mendeley, που διατίθεται δωρεάν, 

ακολουθώ τα παρακάτω βήματα: 

 Μεταβαίνω στη σελίδα https://www.mendeley.com/  

 Επιλέγω Create a free account. 

https://www.lib.auth.gr/sites/default/files/docs_files/MendeleyGuide_Greek_Final.pdf
https://www.mendeley.com/
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 Εισάγω το e-mail της επιλογής μου (δεν απαιτείται να είναι το ιδρυματικό)  και δίνω 

ένα password.  Προαιρετικά, παραμετροποιώ  το προφίλ μου. 

 Έχω στη διάθεσή μου 2 GΒ αποθηκευτικό χώρο στο cloud για τη δημιουργία 

ηλεκτρονικής βιβλιοθήκης αναφορών, με ή χωρίς το πλήρες κείμενο (pdf) και 

πρόσβαση σε αυτήν  από όπου επιθυμώ.   

 

4. Η  Web εκδοχή του Mendeley Reference Manager 

Για πρόσβαση στη βιβλιοθήκη μου ή την εισαγωγή αρχείων, εισέρχομαι στον λογαριασμό 

μου1 μέσω της διεύθυνσης https://www.mendeley.com/  

 

Με τη σύνδεση στο λογαριασμό μου, ανακατευθύνομαι στην αρχική οθόνη όπου 

μπορώ να κάνω αναζήτηση στη βάση του Mendeley (καρτέλα Search, πάνω δεξιά στην 

                                                           

1 Όταν εισέρχομαι στον λογαριασμό μου επιλέγω το  sign in  και όχι το sign in via your institution, καθώς δεν 
πρόκειται για συνδρομητική υπηρεσία του ΑΠΘ. 

https://www.mendeley.com/
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οθόνη).  Μέσω της web εφαρμογής μπορώ να εισαγάγω αρχεία, να τα οργανώσω σε 

φακέλους και να έχω πρόσβαση σε αυτά από παντού. 

Για να προσθέσω αρχεία ή για να δω τα αρχεία που έχω εισαγάγει πηγαίνω στην 

καρτέλα Library.  

Μπαίνοντας στην δεξιότερη καρτέλα με το όνομά μου μπορώ να κάνω τις ρυθμίσεις που 

θέλω για το προφίλ μου ή να αποσυνδεθώ. 

 

5. Εισαγωγή αρχείων στην Βιβλιοθήκη μου      

Δημιουργώ την Βιβλιοθήκη μου με τους εξής τρόπους: 

           1. Εισάγοντας αρχεία pdf   

           2. Εισάγοντας αρχεία σε μορφή bibtext ή ris 

           3. Εισάγοντας δεδομένα  χειροκίνητα    

    

 

                                                                                                                        

 

5.1 Εισαγωγή αρχείων pdf 

Το Mendeley μπορεί και διαβάζει τις ιδιότητες ενός pdf αρχείου προκειμένου να 

δημιουργηθεί η αντίστοιχη βιβλιογραφική αναφορά στη βιβλιοθήκη σας. Με τον τρόπο 

αυτό, πέρα από τη δημιουργία της αναφοράς, έχω και το πλήρες κείμενο στη διάθεσή  μου 

ώστε να το μελετώ από όπου και να βρίσκομαι.  

 

   Επιλέγω  Add new (πάνω αριστερά στην οθόνη)→ File(s) from computer 
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Το Mendeley Reference Manager δεν αποθηκεύει αυτόματα τοπικά τα pdf, αλλά δίνει την 

δυνατότητα για online πρόσβαση και επεξεργασία.  

Μπορώ, ωστόσο, να κατεβάσω τα αρχεία και τοπικά πατώντας το  εικονίδιο files available for 

download.            

 

                                                                                                    

5.2 Εισαγωγή αρχείων σε μορφή Βibtex ή Ris  

Οι περισσότεροι κατάλογοι βιβλιοθηκών και οι βιβλιογραφικές βάσεις δίνουν την 

δυνατότητα αποθήκευσης / εξαγωγής των αποτελεσμάτων τους σε  μορφές αναγνώσιμες 

από προγράμματα δημιουργίας και διαχείρισης ηλεκτρονικής βιβλιογραφίας. Το Mendeley 

μπορεί να αναγνωρίσει και να διαχειριστεί τα  Βibtex ή Ris αρχεία.    

 Επιλέγω το Add new (πάνω αριστερά στην οθόνη) →  File(s) from computer.  Αν 

διαθέτω λειτουργικό σύστημα Mac, επιλέγω το Add new → Import Library. 

 

Αυτός ο τρόπος εισαγωγής εξυπηρετεί: 

 Όταν δεν έχω πρόσβαση στο πλήρες κείμενο (pdf) του υλικού που θέλω να εισαγάγω 

 όταν  δεν επιθυμώ να εισαγάγω το πλήρες κείμενο (επειδή π.χ. είναι πολύ μεγάλο και 

θα εξαντλήσει τον αποθηκευτικό μου χώρο), αλλά με ενδιαφέρουν μόνο τα 

μεταδεδομένα για την βιβλιογραφική αναφορά 

 όταν θέλω να αποθηκεύω μεγάλες λίστες αποτελεσμάτων και όχι μεμονωμένα pdf 

 

Αν διαθέτω ήδη βιβλιοθήκη σε άλλο λογισμικό διαχείρισης βιβλιογραφίας, μπορώ να την 

εξάγω στον υπολογιστή μου σε Bibtext ή Ris  μορφή  και να την εισαγάγω έπειτα στο 

Mendeley.  



Βιβλιοθήκη & Κέντρο Πληροφόρησης ΑΠΘ - Mendeley Reference Manager 

- 7 - 

Τελευταία ενημέρωση: Μάρτιος 2023 

 

5.3 Χειροκίνητη εισαγωγή αρχείων  

Μπορώ να δημιουργήσω  χειροκίνητα μια νέα βιβλιογραφική αναφορά, αντί να την 

εισαγάγω αυτόματα. Αυτή η δυνατότητα είναι χρήσιμη  όταν  δεν έχω πρόσβαση στο αρχείο 

pdf της δημοσίευσης, ούτε μου δίνει η ιστοσελίδα τη δυνατότητα να αποθηκεύσω τα 

αποτελέσματα της αναζήτησής μου σε αρχείο μορφής Bibtex ή Ris.  

 

 

 Επιλέγω  Add new → Add entry manually. 

 Από το πτυσσόμενο μενού  στο πεδίο REFERENCE TYPE επιλέγω τον τύπο υλικού: 

book, journal article κ.λ.π.  

 Συμπληρώνω τα στοιχεία που έχει η φόρμα και τέλος επιλέγω Add entry. Αν το 

τεκμήριο που θέλω να εισαγάγω διαθέτει μοναδικό αναγνωριστικό (π.χ. doi), η 

διαδικασία είναι απλούστερη: το συμπληρώνω στο ανάλογο πεδίο, πατάω τον φακό 
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(αναζήτηση), και, εφόσον εντοπιστεί και έχουν προστεθεί αυτόματα όλα τα πεδία 

επιλέγω Add entry. 

 

6. Επεξεργασία δεδομένων της βιβλιογραφικής αναφοράς 

Ανεξάρτητα από το πώς έχω κάνει εισαγωγή των αρχείων,  μπορώ να παρέμβω στα δεδομένα 

και να κάνω διορθώσεις ή προσθήκες.  

Βάζω την κέρσορα στην αναφορά που με ενδιαφέρει και ενεργοποιούνται στα δεξιά τρεις 

καρτέλες:  Info, Annotations και Notebook. Για να επεξεργαστώ τα μεταδεδομένα της 

αναφοράς μεταβαίνω στην πρώτη καρτέλα Info. 
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7. Οι φάκελοι του Mendeley (Collections) 

7.1 Αυτόματοι φάκελοι 

Στην αριστερή πλευρά της σελίδας στην βιβλιοθήκη εμφανίζονται οι φάκελοι του Mendeley. 

Κάποιοι φάκελοι δημιουργούνται αυτόματα από το Mendeley: 

 All References:  Βλέπω όλα τα αρχεία που έχω εισαγάγει. 

 Recently Added: Βλέπω ό,τι έχω προσθέσει τις τελευταίες 30 ημέρες. 

 Recently Read:  Βλέπω ό,τι έχω διαβάσει τις τελευταίες 30 ημέρες (τα αρχεία με 

πράσινη βούλα είναι τα  μη  διαβασμένα.   Μπορώ να επισημάνω κάτι ως διαβασμένο 

ή μη διαβασμένο απλώς πατώντας στην  βούλα). 

 Favorites:   Βλέπω ό,τι έχω ορίσει ως αγαπημένο, πατώντας το αστεράκι. 

 My Publications:   Σέρνω (drag and drop) από την βιβλιοθήκη μου αρχεία στα οποία 

είμαι συγγραφέας. 

 Trash:  Βλέπω ό,τι έχω διαγράψει. Με δεξί κλικ πάνω στην αναφορά έχω την 

δυνατότητα  να την διαγράψω       οριστικά ή να την επαναφέρω στην Βιβλιοθήκη μου 

(delete permanently / restore).                   
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7.2 Δημιουργία φακέλων 

Εκτός από τους αυτόματους φάκελους μπορώ να δημιουργήσω τους δικούς μου.  

 Στην στήλη αριστερά επιλέγω Collections → New Collection. 

  Με δεξί κλικ δίνω όνομα στον νέο φάκελο.  

 Από τον φάκελο All references  σέρνω σε έναν ή περισσότερους  φακέλους τα αρχεία 

που επιθυμώ. Μπορώ επίσης να το κάνω με δεξί κλικ πάνω στο αρχείο και μεταφορά 

στον φάκελο που επιθυμώ (επιλογή αρχείου και organize).  

 

Σημείωση: Τα αρχεία πάντα θα εμφανίζονται στον φάκελο all references  ανεξάρτητα από 

την οργάνωση των φακέλων. 

 

8. Διαγραφή Αναφορών 

Για να διαγράψω μια βιβλιογραφική αναφορά την επιλέγω και με δεξί κλικ πατώ το delete 

reference.  

Για να διαγράψω μία ή περισσότερες αναφορές , την/τις επιλέγω και πατώ επίσης το delete 

από την οριζόντια μπάρα με τις εντολές που εμφανίζεται στο κάτω μέρος της σελίδας.  

 

Τα διαγραφέντα εντάσσονται αυτόματα στον φάκελο Trash, από όπου μπορώ, επιλέγοντάς 

τα να τα επαναφέρω (Restore) στην βιβλιοθήκη μου, ή να τα διαγράψω οριστικά (Delete 

permanently).  
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9. Η εφαρμογή της επιφάνειας εργασίας (Mendeley Reference Manager for 

Desktop)  

Προαιρετικά, μπορώ να εγκαταστήσω την εφαρμογή της επιφάνειας εργασίας 

Mendeley Reference Manager for Desktop 2 . Η ουσιαστική διαφορά με την διαδικτυακή 

εκδοχή είναι ότι η desktop εφαρμογή  μπορεί να δουλέψει ακόμα και αν είμαι εκτός 

σύνδεσης (offline).   

Κατεβάζω τη νέα εφαρμογή επιφάνειας εργασίας Mendeley Reference Manager από 

εδώ: https://www.mendeley.com/reference-management/reference-manager . Με την 

ολοκλήρωση της εγκατάστασης θα δημιουργηθεί η αντίστοιχη συντόμευση στην επιφάνεια 

εργασίας.                                                                                                              

 Προσοχή: Επιλέγω το σωστό αρχείο για μεταφόρτωση ανάλογα με το λειτουργικό 

σύστημα που χρησιμοποιώ (windows, Linux, MacOs). 

 Κάνω είσοδο στην εφαρμογή με τα διαπιστευτήριά μου, εφόσον έχω δημιουργήσει 

λογαριασμό στην σελίδα https://www.mendeley.com.   

 Μπορώ και στην εφαρμογή, όπως και στην web version, να εισάγω αρχεία, να τα 

οργανώσω σε φακέλους και να έχω πρόσβαση σε αυτά από παντού. 

 Μπορώ να εισάγω στην εργασία μου τις πηγές που χρησιμοποίησα, να δημιουργήσω 

δηλαδή παραπομπές και βιβλιογραφική λίστα. 

 Από την εφαρμογή μπορώ να εγκαταστήσω το εργαλείο Mendeley Cite στο Word  και  

το πρόσθετο Mendeley Web Importer (βλ. τις αντίστοιχες ενότητες).  

 Η εφαρμογή της επιφάνειας εργασίας  & η web εφαρμογή     συγχρονίζονται.  Αυτό 

γίνεται κάθε φορά που ανοίγει κάθε εφαρμογή ή όταν πατάω το εικονίδιο του 

συγχρονισμού. 

                                                           

2 Μην συγχέετε την εφαρμογή Mendeley Reference Manager for Desktop με την παλαιότερη εφαρμογή 
Mendeley Desktop 

https://www.mendeley.com/reference-management/reference-manager
https://www.mendeley.com/
https://www.lib.auth.gr/sites/default/files/docs_files/MendeleyGuide_Greek_Final.pdf
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10.   Mendeley Cite 

Είναι το πρόσθετο (add-in) με το οποίο μπορώ να εισαγάγω τις πηγές στην εργασία μου στο 

Word.  Έχει αντικαταστήσει το παλαιότερο πρόσθετο Mendeley Plugin.                                                          

 Εγκατάσταση μέσω της εφαρμογής της επιφάνειας εργασίας:   

  1. Ανοίγω την εφαρμογή της επιφάνειας εργασίας Mendeley Reference Manager 

Desktop.   

  2. Tools → Install Mendeley Cite for Microsoft Word.  

 Εναλλακτικά, μπορώ να το κατεβάσω απευθείας από  την ιστοσελίδα 

https://www.mendeley.com/reference-management/mendeley-cite  

ή να το ψάξω και να το εγκαταστήσω μέσα από το Word (Insert→ Add-ins → Office 

Store).  

 Tο add-in  Mendeley Cite μπορεί να εγκατασταθεί στις εκδόσεις Microsoft Word 365 

και Microsoft Word 2016 και όχι σε παλαιότερες.   

10. Εισαγωγή αναφορών στην εργασία μου 

 Εγκαθιστώ το Mendeley Cite σύμφωνα με τις παραπάνω οδηγίες. 

 Μετά από την εγκατάσταση  το βρίσκω στην καρτέλα references. 

 Όταν θέλω να εισαγάγω παραπομπή στο κείμενο της εργασίας μου στο word,  

ανοίγω το Mendeley Cite,  βλέπω τα αρχεία που φορτώνονται από την Βιβλιοθήκη 

μου, αναζητώ και επιλέγω την πηγή ή τις πηγές που θέλω και πατώ Ιnsert citation.    

 

 

https://www.mendeley.com/reference-management/mendeley-cite
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 Από την  διπλανή καρτέλα Citation Settings επιλέγω ή αλλάζω το βιβλιογραφικό στυλ.   
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 Για να βάλω την λίστα με τις πηγές (Βιβλιογραφία) πηγαίνω στην καρτέλα more και 

επιλέγω Ιnsert bibliography. Προσέχω να έχω τοποθετήσει τον κέρσορα στο τέλος 

του κειμένου ή στο ακριβές σημείο που θα μπει η βιβλιογραφία.   

 

   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Για να επεξεργαστώ μια αναφορά που έχω εισαγάγει, τοποθετώ τον κέρσορα πάνω 

στην αναφορά, εντός του κειμένου, και ενεργοποιείται η επιλογή Edit citation. 

Ανοίγει ένας πίνακας, ο οποίος μου ζητάει να επιλέξω την πηγή που επιθυμώ (select 

below to edit)  ή την χειροκίνητη επεξεργασία της (manually override).   
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Σε αμφότερες τις περιπτώσεις οι αλλαγές που θα κάνω θα ισχύουν  μόνο στην 

συγκεκριμένη παραπομπή, δηλαδή στο συγκεκριμένο σημείο της εργασίας. 

 

 select below to edit :  κάνω αριστερό κλικ στην πηγή που επιθυμώ & ανοίγει ένας 

πίνακας με συγκεκριμένες προεπιλογές για την επεξεργασία:  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Μπορώ να προσθέσω ή να αφαιρέσω κάποια πηγή. 

 Μπορώ να προσθέσω στην παραπομπή αριθμό σελίδας, αν χρειάζεται (π.χ. στις  

παραθέσεις αποσπασμάτων).   

 Μπορώ να προσθέσω κάποιο επεξηγηματικό κείμενο/σχόλιο στην παραπομπή πριν 

από το όνομα του συγγραφέα (prefix) ή στο τέλος, πριν το κλείσιμο της παρένθεσης 

(suffix). Παράδειγμα: (Stivens, 2010, as cited in Crowle, 2019).  
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 Αν επιλέξω το suppress author αφαιρείται το όνομα του συγγραφέα από την 

συγκεκριμένη παραπομπή  χωρίς να επηρεάζεται η βιβλιογραφική λίστα (π.χ.  όταν 

κάνουμε αναφορά στον συγγραφέα ελεύθερα στη ροή του κειμένου και είναι 

πλεονασμός να τον επαναλάβουμε στην παρένθεση, στην οποία μένει μόνο το έτος 

ή/και ο αριθμός σελίδας). 

 

Αν θέλω να κάνω μόνιμες αλλαγές στην πηγή, τις κάνω από την Βιβλιοθήκη μου στο Mendeley 

(Καρτέλα Info).  

Για να περάσω τις πηγές στην εργασία μου δεν απαιτείται να έχω ανοιχτό το Mendeley Reference 

Manager.  Για να έχω πρόσβαση στη  Βιβλιοθήκη μου, αρκεί να είμαι συνδεδεμένος στο  internet 

και να  ανοίξω το  πρόσθετο  Mendeley Cite. 

 

11. Mendeley Web Importer 

Είναι πρόσθετο που μπορώ να εγκαταστήσω στον φυλλομετρητή (chrome, firefox, Microsoft 

edge).  Πατώντας το αντίστοιχο εικονίδιο του Mendeley Web Importer, που βρίσκεται δίπλα 

από την μπάρα αναζήτησης, ΄΄διαβάζει’’ την σελίδα που βρίσκομαι και προσπαθεί τα 

ανακτήσει τις πληροφορίες των βιβλιογραφικών αναφορών και τα αρχεία πλήρους κειμένου.  

Mου δίνεται δηλαδή η δυνατότητα να επιλέξω μαζικά τις αναφορές (με ή χωρίς pdf) και να 

τα προσθέσω στην βιβλιοθήκη μου.   
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Για να το εγκαταστήσω, ανοίγω τον browser που χρησιμοποιώ και πληκτρολογώ στην μπάρα 

αναζήτησης ‘’Mendeley Web Importer’’ ώστε να ανακατευθυνθώ στην αντίστοιχη ιστοσελίδα 

του Mendeley ή του Φυλλομετρητή.  Για χάριν ευκολίας, παρατίθενται οι παρακάτω 

σύνδεσμοι: 

 Για τον chrome: https://www.mendeley.com/reference-management/web-

importer  

 Για τον Firefox: https://www.mendeley.com/reference-management/web-

importer  

 Για τον Microsoft Edge: 

https://microsoftedge.microsoft.com/addons/detail/mendeley-web-

importer/mbcgpelmjnpfbdnkbebdlfjmeckpnhha  

 

Μπορώ, επίσης, να εγκαταστήσω το Mendeley Web Importer από την εφαρμογή επιφάνειας 

εργασίας (Mendeley Reference Manager →Tools → Install Web Importer). Θα το 

εγκατασταθεί αυτόματα στον browser που έχω προεπιλεγμένο. 

 

Σημείωση: Το Mendeley Web Importer μπορεί να προσθέσει μαζικά μόνο τα αρχεία που 

βρίσκονται στην σελίδα που βρίσκομαι. Αν τα αποτέσματα μιας αναζήτησης εκτείνονται σε 

περισσότερες από μια σελίδες, θα πρέπει να τα εισαγάγω με τον τρόπο που περιγράφεται 

στην ενότητα 5.2 (εισαγωγή bibtext ή Ris αρχείων). 

 

12. Private Groups 

Πρόκειται ουσιαστικά για κοινόχρηστους φακέλους. Δημιουργώντας private group έχω την 

δυνατότητα να προσθέτω και να μοιράζομαι με τα υπόλοιπα μέλη του γκρουπ 

βιβλιογραφικές αναφορές  με το πλήρες κείμενό τους (pdf).  Κάθε ιδιωτικό γκρουπ μπορεί 

να περιλαμβάνει μέχρι 25 άτομα. Μπορώ να δημιουργήσω μέχρι 5 private groups, αλλά να 

συμμετάσχω ως μέλος σε όσα επιθυμώ. 

 

 Δημιουργία group: μεταβαίνω κάτω αριστερά στην οθόνη κάτω από τους 

φακέλους → Groups → New Group→  δίνω όνομα.   

https://www.mendeley.com/reference-management/web-importer
https://www.mendeley.com/reference-management/web-importer
https://www.mendeley.com/reference-management/web-importer
https://www.mendeley.com/reference-management/web-importer
https://microsoftedge.microsoft.com/addons/detail/mendeley-web-importer/mbcgpelmjnpfbdnkbebdlfjmeckpnhha
https://microsoftedge.microsoft.com/addons/detail/mendeley-web-importer/mbcgpelmjnpfbdnkbebdlfjmeckpnhha
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 Διαγραφή group: με δεξί κλικ πάνω στο όνομά του ή επιλέγοντας τις τρεις τελείες 

δεξιά του ονόματος  και  το delete group. 

 Μετονομασία group: με δεξί κλικ πάνω στο όνομα του αντίστοιχου γκρουπ ή 

επιλέγοντας τις τρεις τελείες δεξιά του ονόματος  και  το rename group . 

 Διαχείριση group:  με δεξί κλικ πάνω στο όνομα του αντίστοιχου γκρουπ ή 

επιλέγοντας τις τρεις τελείες δεξιά του ονόματος  και  το manage group . Από εδώ 

μπορώ να κάνω μια γενική επισκόπηση & να διαχειριστώ τα μέλη της ομάδας  

(προσκλήσεις, προσθαφαιρέσεις, αποχωρήσεις).    

 Η δημιουργία και διαχείριση γκρουπ διαφέρει ελαφρώς μεταξύ της web version 

και της desktop εφαρμογής. Για περισσότερες δυνατότητες, επιλέγω το 

διαδικτυακό μου προφίλ. 

 

 

                                             

 

 

 

 

 

13. Annotations 

Στην καρτέλα αυτή βρίσκονται οι σημειώσεις και οι διεργασίες που κάνω στα pdf των 

αναφορών. Ανοίγοντας το κάθε pdf μπορώ να επισημάνω κάποιο μέρος του (highlight) ή να 

προσθέσω μια  σημείωση (sticky note), κάνοντας δεξί κλικ στο σημείο που επιθυμώ ή 

επιλέγοντας την αντίστοιχη εντολή από την μπάρα  που βρίσκεται πάνω από το κείμενο. 

Μπορώ, επίσης, να κάνω μια γενική σημείωση για το pdf μεταβαίνοντας στην καρτέλα 

Annotations  και γράφοντας στο πλαίσιο  General Notes. 
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14. Notebook 

Το Notebook  είναι χώρος συγκεντρωτικός σημειώσεων, τις οποίες μπορώ να δω ενώ 

πλοηγούμαι σε διαφορετικά pdf ή βιβλιογραφικές αναφορές. 

Μπορώ να δημιουργήσω μία ή περισσότερες σελίδες στο Notebook και να προσθέσω 

σημειώσεις ή να συγκεντρώσω σημειώσεις και επισημάνσεις (annotations & highlights) που 

έχω κάνει σε μεμονωμένα pdf.  

 Δημιουργία σελίδας στο Notebook:  Notebook→ New Page (στο κάτω μέρος της 

οθόνης). 

 Πρόσθεση σημείωσης στο Notebook: Αφού επισημάνω ή προσθέσω σημείωση  σε 

κάποιο pdf που με ενδιαφέρει, κάνω αριστερό κλικ→ Add to notebook. 

 

16. Εξαγωγή των pdf με τις σημειώσεις  
 

Για να εξαγάγω το συνημμένο pdf της αναφοράς με τις σημειώσεις που έχω κάνει, μεταβαίνω 

στην στήλη Info, δεξιά της οθόνης, και στο πεδίο FILES, όπου υπάρχει το pdf, πατώ τις τρεις 

τελείες δεξιά του ονόματος του αρχείου και επιλέγω την εντολή export pdf with annotations. 
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17. Αφαίρεση κώδικα από το κείμενο 

Όταν δημιουργώ τις βιβλιογραφικές αναφορές στην εργασία μου με το Mendeley, στο 

έγγραφό μου υπάρχει ο αντίστοιχος κώδικας. Κατά την υποβολή της εργασίας πιθανώς θα 

ζητηθεί να αφαιρεθεί ο κώδικας και να  αποθηκευτεί το έγγραφο ως απλό κείμενο. Έτσι, θα 

μειωθεί το μέγεθος του αρχείου και δεν θα είναι δυνατή πλέον  η επεξεργασία του εγγράφου 

μέσω του Mendeley. Προσοχή: η ενέργεια αυτή είναι μη αναστρέψιμη, συνεπώς πρέπει να 

γίνει μετά την ολοκλήρωσης της επεξεργασίας του εγγράφου σε σχέση με τις βιβλιογραφικές 

αναφορές. Πρέπει επίσης να υπάρχει αποθηκευμένο και ένα αντίγραφο με τον κωδικό του 

Mendeley.  

 Για να αφαιρέσω τον κώδικα του Mendeley, επιλέγω όλο το κείμενο της εργασίας με 

αριστερό κλικ ή πατώντας  Ctrl A  → κάνω δεξί δεξί κλικ → επιλέγω το Remove content 

control (ή Κατάργηση στοιχείου ελέγχου περιεχομένου )  

 

Αν  στην  cloud έκδοση του Microsoft  365  δεν εμφανίζεται αυτή η επιλογή,  αποθηκεύω ένα  

αντίγραφο τοπικά στον υπολογιστή    (File / Save as/ Download a copy to your computer) και 

ανοίγω το έγγραφο με κάποια άλλη έκδοση του Office. 

 

 

 


